## Notices

© Agilent Technologies, Inc. 2010-2017

No part of this manual may be reproduced in any form or by any means (including electronic storage and retrieval or translation into a foreign language) without prior agreement and written consent from Agilent Technologies, Inc. as governed by United States and international copyright laws.

### Manual Part Number
M8301-90092

### Edition
09/2017

Printed in Germany

Agilent Technologies
Hewlett-Packard-Strasse 8
76337 Waldbronn

### Software Revision
This guide is valid for revision C.01.08 of OpenLAB CDS ChemStation Edition.

### Warranty
The material contained in this document is provided “as is,” and is subject to being changed, without notice, in future editions. Further, to the maximum extent permitted by applicable law, Agilent disclaims all warranties, either express or implied, with regard to this manual and any information contained herein, including but not limited to the implied warranties of merchantability and fitness for a particular purpose. Agilent shall not be liable for errors or for incidental or consequential damages in connection with the furnishing, use, or performance of this document or of any information contained herein. Should Agilent and the user have a separate written agreement with warranty terms covering the material in this document that conflict with these terms, the warranty terms in the separate agreement shall control.

### Technology Licenses
The hardware and/or software described in this document are furnished under a license and may be used or copied only in accordance with the terms of such license.

### Restricted Rights Legend
If software is for use in the performance of a U.S. Government prime contract or sub-contract, Software is delivered and licensed as “Commercial computer software” as defined in DFAR 252.227-7014 (June 1995), or as a “commercial item” as defined in FAR 2.101(a) or as “Restricted computer software” as defined in FAR 52.227-19 (June 1987) or any equivalent agency regulation or contract clause. Use, duplication or disclosure of Software is subject to Agilent Technologies’ standard commercial license terms, and non-DOD Departments and Agencies of the U.S. Government will receive no greater than Restricted Rights as defined in FAR 52.227-19(c)(1-2) (June 1987). U.S. Government users will receive no greater than Limited Rights as defined in FAR 52.227-14 (June 1987) or DFAR 252.227-7015 (b)(2) (November 1995), as applicable in any technical data.

### Safety Notices

**CAUTION**
A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in damage to the product or loss of important data. Do not proceed beyond a CAUTION notice until the indicated conditions are fully understood and met.

**WARNING**
A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in personal injury or death. Do not proceed beyond a WARNING notice until the indicated conditions are fully understood and met.
In this Guide ...

This installation guide provides instructions to install and configure Agilent OpenLAB CDS ChemStation Edition workstations.

Table 1  Terms and abbreviations used in this document

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CDS</td>
<td>Chromatography Data System</td>
</tr>
<tr>
<td>ChemStation</td>
<td>OpenLAB CDS ChemStation Edition</td>
</tr>
<tr>
<td>Secure Workstation</td>
<td>Secure Workstation for OpenLAB CDS ChemStation Edition</td>
</tr>
<tr>
<td>Data Store</td>
<td>OpenLAB Data Store; as of rev. 2.1, the product name is OpenLAB Server</td>
</tr>
<tr>
<td>OpenLAB Server</td>
<td>Data Storage product, formerly known as OpenLAB Data Store.</td>
</tr>
<tr>
<td>Content Management</td>
<td>Data storage component provided as part of OpenLAB Server</td>
</tr>
<tr>
<td>ECM</td>
<td>OpenLAB Enterprise Content Manager</td>
</tr>
<tr>
<td>AIC</td>
<td>Agilent Instrument Controller</td>
</tr>
<tr>
<td>Control Panel</td>
<td>OpenLAB Control Panel</td>
</tr>
<tr>
<td>Microsoft Control Panel</td>
<td>Part of the Microsoft Windows operating system</td>
</tr>
<tr>
<td>Shared Services</td>
<td>Set of components and services for licensing, users and roles, instrument configuration, security policy and more. Installed on all computers; accessed via the OpenLAB Control Panel.</td>
</tr>
<tr>
<td>OpenLAB CDS Shared Services Server</td>
<td>Server running the Shared Services. Formerly known as OpenLAB Shared Services Server.</td>
</tr>
</tbody>
</table>
1 **Configure your Workstation PC**

Agilent-delivered PC Bundle systems are delivered with the supported pre-installed Windows operating system and are configured for optimum performance. Non-Agilent PCs require some manual configuration changes in order to provide optimum performance. This chapter describes how to configure a non-Agilent PC.

2 **Install the Software**

The installation is automated by the OpenLAB CDS ChemStation Master Installer. This tool installs the all components needed.

3 **Post Installation Tasks**

This chapter describes tasks that are relevant after finishing the installation.

4 **Optional Procedures**

This chapter contains information on the Additional Drivers and Software wizard, on the Software Verification Tool, and other helpful procedures.

5 **Licensing**

This chapter contains information on how to obtain and install a license.

6 **Configure OpenLAB CDS ChemStation Edition in the Control Panel**

This chapter describes the initial configuration steps after installing the software. Refer to the online help for more information.

7 **Upgrade ChemStation Edition to Latest Version**

If you upgrade from an older ChemStation revision, upgrade to C.01.07 first. For information on upgrading from ChemStation A.0x or B.0x, please refer to the migration guide (CDS_CS-data-Migration.pdf).

8 **Uninstall the Software**

This chapter contains information on the uninstallation by using the OpenLAB Uninstallation Wizard. It also describes post uninstallation tasks that are essential if you plan to reinstall ChemStation on the same computer.

9 **Troubleshooting**

The chapter gives some troubleshooting hints.
Contents

1 Configure your Workstation PC 7
   About Configuration 8
   Installing Windows 9
   Windows Configuration Check for OpenLAB CDS ChemStation Edition 10
   Configuring Windows 7 11
   Configuring Windows 10 16
   Editing the Security Settings for LC/MS and CE/MS Systems 21

2 Install the Software 25
   Before You Begin 26
   Step 1: Prepare for Installation 28
   Step 2: Install Third Party Tools 29
   Step 3: Copy Installation files to a Centralized Folder for Installation (Optional) 31
   Step 4: Run the System Configuration Checker 32
   Step 5: Run the Installation Wizard 33
   What to do Next 36
   Scripted Installation 37

3 Post Installation Tasks 43
   Configure the Antivirus Program 44
   Configure Default Printer 46
   Add Shortcut to Public Folder 47

4 Optional Procedures 49
   Install Additional Software and Drivers 50
   Run a Software Verification after Software Installation 51
   Transform a Workstation to a Networked Workstation 52
   Improve Performance on Offline Machines 54
   Protect ChemStation Folders with Secure File I/O 55
   Change the PC Name 56
## Contents

5 **Licensing** 61
- About OpenLAB Licensing 62
- Get a License 63
- Install Your License 68

6 **Configure OpenLAB CDS ChemStation Edition in the Control Panel** 69
- Configure Authentication 70
- Configure Security Policy 72
- Configure Users/Groups/Roles 72
- Install your License 76
- Configure Instruments 77

7 **Upgrade ChemStation Edition to Latest Version** 79
- Planning the Upgrade 80
- Convert Classic Instrument Drivers to RC.NET 82
- License Upgrade 85
- Run the C.01.08 Upgrade Wizard 88

8 **Uninstall the Software** 91
- About Uninstallation 91
- Run the OpenLAB CDS Uninstallation Wizard 92

9 **Troubleshooting** 93
- Reconfigure Instruments Using Classic Drivers After Upgrade to ChemStation C.01.08 94

10 **Appendix** 97
- Sales and Support Assistance 97
1 Configure your Workstation PC

About Configuration 8
Installing Windows 9
Windows Configuration Check for OpenLAB CDS ChemStation Edition 10
Configuring Windows 7 11
Configuring Windows 10 16
Editing the Security Settings for LC/MS and CE/MS Systems 21
  Firewall 21
  Advanced Network Settings 22

Agilent-delivered PC Bundle systems are delivered with the supported pre-installed Windows operating system and are configured for optimum performance. Non-Agilent PCs require some manual configuration changes in order to provide optimum performance. This chapter describes how to configure a non-Agilent PC.
Some changes within this document are mandatory for OpenLAB CDS ChemStation Edition to work properly on a Windows system. Some changes will optimize application performance. Other changes will have a graphical or minor impact.

**NOTE**

To indicate the relative importance of individual settings, each item is categorized as:

**MUST:** These changes must be applied.

**PERFORMANCE:** These changes will improve system performance.

**OPTIONAL:** Most of these changes will affect the graphical display of the application.

**NOTE**

If User Account Control (UAC) is switched on, some configuration steps will require active confirmation to continue.
Installing Windows

1. Install the Windows operating system from the Microsoft installation media or qualified PC image media provided by your IT department. During the setup, provide the computer name, administrator password and network settings. Choose to either join an existing domain or set up the system in a workgroup mode.

2. For Windows 10 Pro users: Update to the latest Windows 10 edition in accordance to the guidelines of your local IT department.

3. To secure your system against viruses please install an antivirus program. Be sure to open the firewall ports listed in the Firewall Settings in the OpenLAB CDS ChemStation Edition Requirements guide.

NOTE
Keep your PC disconnected from the internet until you have installed the appropriate security patches and hot fixes. Install the latest security fixes as supported from Agilent Technologies and virus definitions prior to connecting to a network.

NOTE
Running antivirus programs might influence the behavior and performance of your computer. Some virus scanners might cause issues when used with OpenLAB CDS. The application is tested with Symantec Endpoint Protection 12.x and with Microsoft Security Essentials.
Windows Configuration Check for OpenLAB CDS ChemStation Edition

The OpenLAB CDS configuration check tool helps to troubleshoot the Operating System configuration and to prevent computer problems. It checks and repairs all mandatory settings. It does not check optional settings or settings that improve the performance.

The tool comes as .diagcab file, which is a file format used with the Microsoft Windows Troubleshooting Platform (WTP) program. The Microsoft Windows Troubleshooting Platform (WTP) is a platform to locate and fix hardware and software settings in Windows. It is used specifically for diagnosing and repairing computer settings.

In general, .diagcab files are useful for deploying troubleshooting packs because they are self-contained and require no installation. The .diagcab file name extension is a registered file name extension that can be executed by WTP.

To start the configuration check, call the file Agilent.Wtp.ChemStation.WindowsConfiguration.diagcab. This file is located in Disk6\Tools\OpenLAB CDS ChemStation Edition\Diagnostics\WindowsConfiguration\Cab\n
**NOTE**

While using the Configuration Checker:

- Ensure that this computer is not turned off by another user.
- Win 7: Ensure that the menu bar is enabled (click Organize > Layout and select Menu bar).
Configure Windows as described in the following steps. Alternatively, run the OpenLAB CDS configuration check tool (see “Windows Configuration Check for OpenLAB CDS ChemStation Edition” on page 10).

**NOTE**
Make sure that Windows hotfix KB2999226 (*Update for Universal C Runtime in Windows*) is installed on your system before installing ChemStation.


[MUST] 1 **System** (Microsoft Control Panel): Register Windows with Microsoft.

[MUST] 2 **Folder Options** (Microsoft Control Panel): In the View tab,
   - Select *Always show menus*.
   - Select *Display the full path in the title bar*.
   - Clear *Hide extensions for known file types*.
   - Clear *Use Sharing Wizard*.

[MUST] 3 **Windows Update** (Microsoft Control Panel):
   a  Click *Check for updates* to check for updates and apply all critical security patches.
   b  Click *Change settings*. In the *Important updates* section, select *Never check for updates*. Clear the other update options.

**NOTE**
This setting is important to avoid data loss due to system reboot during data acquisition.

   a  Double-click *Services*.
   b  Double-click the following services and set their startup type to **Disabled**:
      - *Application Experience*
      - *Desktop Window Manager Session Manager*

1 View the items by icon to see a list of all items.
[MUST] 5 **Administrative Tools** (Microsoft Control Panel): Configure security options:
   a. Double-click **Local Security Policy**.
   b. Navigate to **Security Settings > Local Policies > Security Options**
   c. Double-click the following policy listed in the right hand panel: **Network Access: Sharing and security model for local accounts**
   d. In the displayed dialog select the following item from the drop-down list: **Classic - local users authenticate as themselves**

[MUST] 6 **Indexing Options** (Microsoft Control Panel): Disable indexing.
   Click the **Modify** button. Clear all drives and locations.

[MUST] 7 **Power Options** (Microsoft Control Panel):
   a. As preferred plan select **High performance**
   b. Click **Change Plan settings**
   c. Set the option **Put the computer to sleep** to **Never**.
   d. Click **Change advanced power settings**.
   e. Open the nodes for **Hard disk > Turn off hard disk after**.
   f. Set the Minutes to 0 (=Never).

[MUST] 8 **Region and Language** (Go to **Control Panel > Region and Language**).
   a. Regional options should be set to **English (United States)** from the drop-down list.
   b. If regional format other than **English (United States)** is used, the following settings are mandatory. The settings can be defined by clicking on the **Additional settings...** button:
      - Decimal symbol = . (point)
      - Digit grouping symbol = , (comma)
      - List separator = , (comma)

[MUST] 9 **Date and Time** (Microsoft Control Panel): Choose the time zone of your machine's location.

[MUST] 10 **Network and Sharing Center** (Microsoft Control Panel):
   a. Select **Change adapter settings**. Right-click **Local Area Connection > Properties > Configure**.
   b. On the **Power Management** tab, clear all check boxes.
[MUST] 11 Programs and Features (Microsoft Control Panel):
   a  Click Turn Windows features on or off.
   b  Expand the Microsoft .NET Framework 3.5.1 node and select the Windows Communication Foundation Non-HTTP Activation check box.
   c  Select the Internet Explorer 11 check box.
   d  Select the Telnet Client check box.
   e  Select the TFTP Client check box.
   f  Reboot the PC.

[MUST] 12 Only for Standalone Workstations that do not belong to a domain: Start > search for 'gpedit.msc': Windows logon options:
   a  Navigate to Local Computer Policy > Computer Configuration > Administrative Templates > System > Logon.
   b  Set Hide entry points for Fast User Switching and Always use classic logon to Enabled.

[MUST] 13 Disable Compatibility View in Internet Explorer.
   a  Open Internet Explorer.
   b  Click the Tools menu, and then click Compatibility View Settings.
   c  Clear the Display intranet sites in Compatibility View check box.

[MUST] 14 Enable the navigation pane:
   Open Windows Explorer, then select Organize > Navigation pane and make sure that Navigation pane is selected.

[PERFORMANCE] 15 System (Microsoft Control Panel): Change performance options:
   a  Click Advanced system settings.
   b  On the Advanced tab > Performance click Settings.
   d  Under Custom, select the following check boxes for better usability:
      - Smooth edges of screen fonts
      - Show shadows under mouse pointer
      - Show shadows under windows
Configure your Workstation PC
Configuring Windows 7

[PERFORMANCE] 16 System (Microsoft Control Panel): Change system properties:

  a. Click Advanced system settings.
  b. On the Advanced tab > Performance click Settings.
     - Advanced tab > Virtual Memory: For optimum performance use the Change button to adjust the paging file size to a value of 2 to 3 times of the physical RAM on the PC. If possible locate the paging file on a drive different from the system installation drive.
     - Data Execution Prevention tab: Select Turn on DEP for essential Windows programs and services only.
  c. Advanced > Startup and Recovery > Settings button:
     - System startup section:
       Change both Time to display ... fields from 30 to 3 sec.
     - System failure section:
       Select Automatically restart, in the Write debugging information section select Kernel memory dump from the drop-down list.
  d. System Protection tab
     Make sure that Protection is turned off. If required, click Configure and select Disable system protection.
  e. Remote tab
     - In the Remote Assistance section, clear the check box Allow Remote Assistance connections to this computer.
     - In the Remote Desktop section, select Don’t allow connections to this computer.

[OPTIONAL] 17 General Layout: (right-click Start > Properties)

  a. Start Menu Tab: In the Privacy section select both items
  b. Start Menu Tab > Customize button: In Customize Start Menu dialog:
     - Clear the following option:
       - Favorites menu
     - Select the following options:
       - Computer Display as a link
       - Connect To
       - Control Panel: Display as a menu
       - Default Programs
       - Devices and Printers
Configure your Workstation PC
Configuring Windows 7

- Documents: Display as a link
- Enable context menus and dragging and dropping
- Games: Don’t display this item
- Help
- Highlight newly installed programs
- Music: Don’t display this item
- Network
- Open submenus when I pause on them with the mouse pointer
- Personal folder: Display as a link
- Pictures: Display as a link
- Run command
- Search other files and libraries Search with public folders
- Search programs and Control Panel
- Sort All Programs menu by name
- System administrative tools: Display on the All Programs menu and in the Start menu
- Use large icons

[OPTIONAL] 18 Start > search for ‘gpedit.msc’: Welcome Center:
  a Navigate to Local Computer Policy > Computer Configuration > Administrative Templates > System > Logon.
  b Set Don’t display the Getting Started welcome screen at logon to Enabled.

[OPTIONAL] 19 Recycle Bin Properties: (right-click on desktop icon Recycle Bin) Select the following options:
  - Custom size: Select a size corresponding to approximately 10% of the complete disk space for the drive.
  - Select Display delete confirmation dialog.
Repeat these steps for all drives of your computer.

[OPTIONAL] 20 Region and Language (Microsoft Control Panel): Language for non-Unicode programs: On the Administrative tab, click Change system locale.... From the drop down list, select English (United States)

NOTE
Do not change the system locale if you are using an English, Japanese or Chinese Operating System.
Configure Windows as described in the following steps. Alternatively, run the OpenLAB CDS configuration check tool (see “Windows Configuration Check for OpenLAB CDS ChemStation Edition” on page 10).

**NOTE**
The following descriptions apply to Windows 10 Build 1607. The settings for higher builds may differ slightly.

**[MUST]**

1. **System** (Microsoft Control Panel): Register Windows with Microsoft.
2. **File Explorer Options** (Microsoft Control Panel): In the **View** tab:
   - Select **Always show menus**.
   - Select **Display the full path in the title bar**.
   - Clear **Hide extensions for known file types**.
   - Clear **Use Sharing Wizard**.

**[MUST]**

3. **Start > Settings > Update and Security**:
   a. Click **Check for updates** to check for updates and apply all patches.
      
      Before proceeding, ensure that all updates are downloaded and installed. Ensure that there is no reboot pending.
   b. Click **Advanced options**.
   c. Select the **Defer feature updates** check box.
   d. Click **Choose how updates are delivered**.
   e. Turn off **Updates from more than one place**.

**[MUST]**

4. Settings for updates: **Windows Update** service MUST NOT be running during installation.

**[MUST]**

5. **Indexing Options** (Microsoft Control Panel): Disable indexing.
   
   Click the **Modify** button. Clear all drives and locations.

**[MUST]**

6. **Start > Settings > System > Tablet Mode**: For **When I sign in**, select **Use desktop mode**.

1 View the items by icon to see a list of all items.
[MUST] 7 Power Options (Microsoft Control Panel):
   a As preferred plan select High performance
   b Click Change Plan settings
   c Set the option Put the computer to sleep to Never.
   d Click Change advanced power settings.
   e Open the nodes for Hard disk > Turn off hard disk after.
   f Set the Minutes to 0 (=Never).

[MUST] 8 Start > Settings > System > Offline Maps: Turn Metered connections and Map updates off.

[MUST] 9 Administrative Tools (Microsoft Control Panel): Configure security options:
   a Double-click Local Security Policy.
   b Navigate to Security Settings > Local Policies > Security Options
   c Double-click the following policy listed in the right hand panel: Network Access: Sharing and security model for local accounts
   d In the displayed dialog select the following item from the drop-down list: Classic - local users authenticate as themselves

[MUST] 10 Security and Maintenance (Microsoft Control Panel):
   a Click Change Windows SmartScreen settings.
      Select Don't do anything (turn off Windows SmartScreen).

[MUST] 11 Date and Time (Microsoft Control Panel): Choose the time zone of your machine's location.

[MUST] 12 Network and Sharing Center (Microsoft Control Panel):
   a Select Change adapter settings. Right-click Local Area Connection > Properties > Configure.
   b On the Power Management tab, clear all check boxes.

[MUST] 13 Programs and Features (Microsoft Control Panel):
   a Click Turn Windows features on or off.
   b Enable .NET 3.5 by selecting the .NET Framework 3.5 (includes .NET 2.0 and 3.0) check box.
      This option requires an internet connection.
1 Configure your Workstation PC
Configuring Windows 10

If this procedure does not work as expected, or the computer has no internet access, install .NET 3.5 from the Windows installation media (see details for Windows 10 under https://support.microsoft.com/en-us/kb/2734782). If you do not have installation media, create them as described under https://www.microsoft.com/en-us/software-download/windows10.

c To make sure that all the net.tcp components are properly initialized, Non-HTTP activation must be enabled. Expand the .NET Framework 3.5 (includes .NET 2.0 and 3.0) node and select the Windows Communication Foundation Non-HTTP Activation check box.

d Select the .NET Framework 4.6 Advanced Services check box. Use the default values for sub items.

e Select the Internet Explorer 11 check box.

f Select the Telnet Client check box.

g Select the TFTP Client check box.

h Reboot the PC.

14 Start > Settings > System > Default Apps: Select Internet Explorer as default Web browser.

[MUST] 15 Disable Compatibility View in Internet Explorer.

a Open Internet Explorer.

b Click the Tools menu, and then click Compatibility View Settings.

c Clear the Display intranet sites in Compatibility View check box.

[MUST] 16 Enable the navigation pane:

Open Windows Explorer, then select View > Navigation pane from the ribbon and make sure that Navigation pane is selected.

[PERFORMANCE] 17 System (Microsoft Control Panel): Change performance options:

a Click Advanced system settings.

b On the Advanced tab > Performance click Settings.


d Under Custom, select the following check boxes for better usability:

- Smooth edges of screen fonts
- Show shadows under mouse pointer
- Show shadows under windows
Configure your Workstation PC

18 Start > Settings > Personalization > Colors: Turn Make Start, taskbar, and action center transparent off.

19 System (Microsoft Control Panel): Change system properties:
   a Click Advanced system settings.
   b On the Advanced tab > Performance click Settings.
      - Advanced tab > Virtual Memory: For optimum performance use the Change button to adjust the paging file size to a value of 2 to 3 times of the physical RAM on the PC. If possible locate the paging file on a drive different from the system installation drive.
      - Data Execution Prevention tab: Select Turn on DEP for essential Windows programs and services only.
   c Advanced > Startup and Recovery > Settings button:
      - System startup section:
         Change both Time to display ... fields from 30 to 3 sec.
      - System failure section:
         Select Automatically restart, in the Write debugging information section select Kernel memory dump from the drop-down list.
   d System Protection tab
      Make sure that Protection is turned off. If required, click Configure and select Disable system protection.
   e Remote tab
      - In the Remote Assistance section, clear the check box Allow Remote Assistance connections to this computer.
      - In the Remote Desktop section, select Don't allow connections to this computer.

20 Start > Settings > Personalization: Disable advertising info:
   a On the Lock screen page:
      - Under Background, select Picture or Slideshow.
      - Turn off Get fun facts, tips, tricks, and more on your lock screen.
      - Turn off Show lock screen background picture on the sign-in screen.
   b On the Start page:
      Turn off Occasionally show suggestions in Start.
Configure your Workstation PC
Configuring Windows 10

[OPTIONAL] 21 Start > Settings > Privacy:
   a On the General page, turn off the following:
      • Let apps use my advertising ID
      • Turn on SmartScreen Filter to check web content
      • Send Microsoft info about how I write
   b On the Location page, turn off Location.

[OPTIONAL] 22 Start > search for 'gpedit.msc': Welcome Center:
   a Navigate to Local Computer Policy > Computer Configuration > Administrative Templates > System > Logon.
   b Set Don't display the Getting Started welcome screen at logon to Enabled.

[OPTIONAL] 23 Recycle Bin Properties: (right-click on desktop icon Recycle Bin) Select the following options:
   • Custom size: Select a size corresponding to approximately 10% of the complete disk space for the drive.
   • Select Display delete confirmation dialog.
   Repeat these steps for all drives of your computer.

24 Region (Microsoft Control Panel): Language for non-Unicode programs:
   On the Administrative tab, click Change system locale.... From the drop down list, select English (United States).

NOTE
Do not change the system locale if you are using an English, Portuguese, Japanese or Chinese Operating System.

[OPTIONAL] 25 Right-click the taskbar to open the Taskbar and Start Menu Properties dialog. In the Taskbar tab, under Taskbar buttons select Combine when taskbar is full.
   This will simplify switching between open CDS instances.
Editing the Security Settings for LC/MS and CE/MS Systems

The following sections summarize all security settings required for LC/MS and CE/MS. All other security settings are set automatically by the OpenLAB CDS ChemStation Master Installer.

OpenLAB CDS ChemStation Edition needs to be installed using an operating system Administrator user account. To run the system with the configured options outlined in this document, all users and power users should use the same settings.

Firewall

On PCs controlling LC/MS or CE/MS systems, it is recommended that you turn off the firewall.
1 Configure your Workstation PC

Editing the Security Settings for LC/MS and CE/MS Systems

Advanced Network Settings

The communication with the MS is sensitive to the order NICs in the Adapters and Bindings dialog.

1 Go to Start > Control Panel.
   Go to Network and Sharing Center.  

2 Click Change adapter settings.

3 Press ALT to bring up the menu.

4 Select Advanced Settings....

![Figure 1](image1.png)

**Figure 1** Advanced Settings dialog, Adapters and Bindings tab

1 View the items by icon to see a list of all items.
In the Adapters and Bindings tab (see Figure 1 on page 22):

Make sure that the Local Area Connection pertaining to the **LC/MS** or **CE/MS** NIC is the first item in the list of connections.

**NOTE**

The names of your LAN cards may differ from those shown in the example. You can tell which LAN card is the Instrument LAN by comparing the IP addresses assigned to the LAN cards.

The LAN pertaining to the company intranet > internet will typically have an IP address assigned by organizations Static IP policy or by a DHCP server. Check with your network administrator.
Configure your Workstation PC
Editing the Security Settings for LC/MS and CE/MS Systems
2

Install the Software

Before You Begin 26
Step 1: Prepare for Installation 28
Step 2: Install Third Party Tools 29
  Install Adobe PDF Reader 29
  Install .NET 4.6 30
  Install Keysight IO Libraries Suite 30
Step 3: Copy Installation files to a Centralized Folder for Installation (Optional) 31
Step 4: Run the System Configuration Checker 32
Step 5: Run the Installation Wizard 33
  License Agreement Screen 33
  Installation Folder Screen 33
  Installation Type Screens 34
  Summary Screen 35
What to do Next 36
Scripted Installation 37
  About Scripted Installation 37
  Export as XML 37
  Parameters and Return Codes 38
  Installation, Upgrade, or Repair 41
Uninstallation 42
Logging and Tracing 42

The installation is automated by the OpenLAB CDS ChemStation Master Installer. This tool installs the all components needed.
Before You Begin

To simplify installation of the software, it is helpful to decide on some configuration options before you begin the actual software installation.

1. Decide on a computer name.
   The computer name will be reflected in the instrument configuration. To avoid considerable effort, it is recommended to keep the computer name unchanged after installing OpenLAB CDS ChemStation Edition.

**NOTE**
To make sure that a DNS server can resolve the computer name, follow the internet standard for protocols (RFC952) and use only the following characters:

- Letters (a-z, A-Z)
- Digits (0-9)
- Hyphen (-)
   Do not use an underscore.

2. For installing OpenLAB CDS, you need to have administrator privileges for all servers and clients. Power user privileges are not sufficient (the installation does not start).

3. Decide on a directory location to store all files related to the data system software, including data, methods, sequences, and configurations. The directory must always be accessible to the PC running the software.

4. If you will be using OpenLAB ECM with your system, obtain the ECM server name.

**NOTE**
Make sure you have administrator privileges for both ECM and OpenLAB.

5. Decide on the software delivery approach you want to use:
   - *Install directly from the USB medium* — Insert the USB medium directly at the workstation computer. (Recommended)
   - *Copy installation files to a centralized location* — You can use the utility to copy the installation files, for example, to a network share folder, and run the installation from that location. However, some networks may interfere with installation.
6 When you launch the application, you will be able to review the following PDFs in the installer **Planning** menu before you install the software.

- *OpenLAB CDS Requirements* — Use this PDF to check that your settings comply with the network requirements, and to determine whether your hardware and software will support the system.
- *OpenLAB CDS Workstation* — A link to this installation guide in PDF format is provided for your convenience.

7 Install all required hardware, including any A/D connections, interfaces, instrument detectors, and communication cables.

8 Make sure that a default printer is configured in Windows. The printer driver must be for a physical printer, even if the printer is not connected.

   This is done via the Microsoft Control Panel. If no default printer is configured the following problems may occur:
   - Printing of a report preview will fail
   - the **Copy To Clipboard** menu will have an error
   - the **Custom Report View** will have problems with new templates

**NOTE**

During the installation of the ChemStation, a PDF XChange 6 printer driver is installed. This printer has the following limitations:

   - The maximum number of pages for one print job is 1500. For example sequence summary report is one print job.
   - When printing Multi Page chromatograms, the maximum number of pages which can be printed properly depends on the resolution of the printer. 300 dpi allows 10 pages, 600 dpi allows up to 5 pages per chromatogram.

9 Make sure .NET 3.5 and .NET 4.6 are activated as Windows features.

   For installation instructions, see “Install .NET 4.6” on page 30.

10 Make sure that the antivirus software is disabled during the installation.

11 Make sure that no upgrades will run for any software during the installation.

12 Make sure that no system reboot is pending.

   Pending reboots are indicated both in the Configuration Checker (see “Windows Configuration Check for OpenLAB CDS ChemStation Edition” on page 10) and in the Site Preparation Tool (see “Step 4: Run the System Configuration Checker” on page 32).
Step 1: Prepare for Installation

To prepare for an installation on your workstation:

1. For the direct approach, insert the installation medium.
2. For the shared file approach, copy all installation files to a centralized folder as described below.

To begin installation, navigate to `\Disk1\Setup.bat`. Right-click the file and run it as administrator to proceed to the **Planning** screen.
Step 2: Install Third Party Tools

The OpenLAB CDS ChemStation Master Installer offers a list of tools that can be installed directly from the Installation screen.

Install Adobe PDF Reader

You need Adobe Reader DC Classic to ...
- view site prep or administrative reports (such as system reports)
- use the Report Viewer feature
- view Software Verification Reports

NOTE
If an older version of Acrobat Reader (11 or earlier) is installed on your system, you must deinstall it first. Adobe updates would raise those versions to Acrobat Reader DC Continuous, which pushes automatic updates on a regular basis.

To install Adobe Reader DC Classic:
1 In the Master Installer, select Installation.
2 Under Third Party Tools, select Adobe PDF Reader.
   a The Adobe Reader setup screen appears. Click Install to continue.
   b If Adobe Reader was successfully installed, click Finish to exist the setup screen.

Alternatively, you can install Adobe Reader from the ChemStation installation medium. It is available under Disk1/Tools/Adobe Reader.

Run AcroRdr2015_MUI.bat and follow the instructions of the Adobe Reader Setup wizard.

NOTE
If you install Adobe PDF Reader directly from the installation medium: When you open a PDF file for the first time, you will be asked to confirm the Adobe Reader license agreement. This dialog will appear for each newly configured instrument.
2 Install the Software
Step 2: Install Third Party Tools

Install .NET 4.6

If .NET 4.6.1 is not installed on your system, its installation will automatically be triggered by the installation wizard. However, Windows requires write access to the installation files. Installing directly from the USB medium will therefore not be possible.

1. Copy the folder Disk1\Tools\DotNet4.6 to a local disk.
2. Run dotNetFx_Full_x86_x64.bat.
3. Follow the installation wizard.
4. Restart the computer.

Install Keysight IO Libraries Suite

IO Libraries are required only for LC/MS and CE/MS instruments.

To install IO Libraries, visit the Keysight download page:
http://www.keysight.com/upload/cmc_upload/All/readme_IOLS_17_2_20605_2.htm.
Step 3: Copy Installation files to a Centralized Folder for Installation (Optional)

Completing this step will enable you to run an installation from a network share.

1. From the Master Installer **Planning** screen, select **Installation** from the sidebar menu.
2. Select **Preparation of an Installation from Network Share**.
3. At the **Network Share** screen, browse to a directory and create a destination folder as follows:
   a. Select the button with the three dots.
   b. Navigate to the directory where you want to create the folder.
   c. Select **Make New Folder**.
   d. Type in the folder name.
   e. Select **OK**. The system will return you to the **Network Share** screen, with the path displayed.
   f. Select the content you want to copy to the folder, corresponding to the required installation scenario.
   g. Select **Start**.
4. When processing is complete, copy the files to the local drive or map the location to a network drive.
5. Close the application and navigate to the directory and folder you created. Open the folder.
6. Select the Disk 1 folder, then execute **Setup.bat** to run the application. The system will display the installer **Planning** screen.

**NOTE**
Installations into the root of a drive may cause problems during operations and are not supported.
**Step 4: Run the System Configuration Checker**

1. Run the Master Installer from the USB medium or from a centralized folder. From the **Planning** screen, select **System Configuration Checker**.

2. The **Site Preparation Tool** opens. Select **OpenLAB CDS ChemStation Edition C.01.XX** from the drop-down list.

3. Select **OK**.

4. Complete page 1 of the **Contact Information—System details** by typing in the fields provided.
   - System Location fields
   - System Information fields
   - Configuration fields

5. Review the system details and make any necessary entries. The system will follow the paths specified.

6. Select the green check mark icon in the top left corner of the screen to begin the software check. A summary report is displayed showing the results for each check category. Results are expressed as **Pass**, **Warning**, **Critical Warning**, or **Fail**.

   **Fail** results must be corrected before continuing with the installation. Agilent recommends investigating and correcting any **Critical Warnings** and **Warnings** whenever possible before proceeding.

**NOTE**

If the firewall is controlled by security software, the Site Preparation Tool cannot read the firewall settings because of security limitations and will display **Status "Fail"** for the firewall settings.

In this case, make sure the firewall is disabled and enter the status in the Site Preparation Tool report manually.

7. To view details of the report, select the appropriate link: **System Hardware Details**, **Operating System and Software Details**, or **Manual Verification Required**.

8. To save the report, select the **Save** icon at the top left of the screen.

9. E-mail the saved report to your Agilent Service Representative for evaluation, and for validation of your personal computer for Agilent Software Systems Installs.
Step 5: Run the Installation Wizard

License Agreement Screen

1. From the OpenLAB CDS ChemStation Master Installer, select **Installation**.
2. Select **OpenLAB CDS ChemStation**.
3. The **OpenLAB CDS Installation Wizard** opens. Read the terms of the **License Agreement**. Master Installer provides a printable PDF of the license agreement under the **Resources** option of the main menu.
4. Select **I agree with the terms and conditions**. You cannot proceed with installation unless you agree to these terms.
5. Select **Next** to proceed to the **Installation Folder** screen.

Installation Folder Screen

1. Type the folder name or browse to the directory where you want to store the application components (typically this is in the programs folder). Folders must have English names.

   **NOTE** Installations into the root of a drive may cause problems during operation and are not supported.

2. To run an installation verification as part of this installation, select **Run Software Verification**. The Software Verification Tool provides documentary evidence that your system has been built and installed correctly, and that all design specifications have been met. You can run the Software Verification Tool at a later time if you prefer (see “Run a Software Verification after Software Installation” on page 51).
3. Select **Next** to proceed to the **Installation type** screens.
Install the Software
Step 5: Run the Installation Wizard

**Installation Type Screens**

1. Under **Installation type**, select **Standalone Workstation**.
2. Under **OpenLAB CDS ChemStation Edition**, provide the following folder paths:
   - **Installation folder**: directory where you want to store the ChemStation application components. Typically this is in the programs folder. Folder names must be entered without spaces.
   - **Instrument data folder**: Instrument specific data such as methods, sequences, and results. The default data path is the public documents folder. If you plan to activate the Secure File I/O feature, this folder must not be shared at a later point in time. If your PC is equipped with a second disk drive, it is recommended to change the default data path to this alternative drive. Using a second disk drive increases the performance.
3. Select **Next** to proceed to the **Additional items** screen.
4. If you want to use OpenLAB ECM 3.4 or 3.5 with your data system:
   - a. Select **ECM 3.x Server**. Type in a server name and press the **Test Connection...** button.
   - b. The system will perform a connectivity check to verify access to a functional OpenLAB ECM server. If the connectivity check is successful, the message **Connection succeeded** appears. Click **OK** to continue. If the connectivity test fails, you will be returned to the **Additional items** screen. From here you can select **Next** to run the test again. If the test is still unsuccessful:
      - Enter a new OpenLAB ECM server and try another test.
      - Call internal support for assistance if you cannot connect to an OpenLAB ECM server.
      - You can uncheck the box and run the installation without OpenLAB ECM at this time. You will be able to add it to your data system at a later time, when a server is determined.

**NOTE**
The storage type **OpenLAB Server** is only available for a Networked Workstation or a Distributed System.

5. Select **Next** to proceed to the **Summary** screen.
Install the Software

Step 5: Run the Installation Wizard

Summary Screen

1. Review the installation settings that you have selected in the preceding steps. Select **Back** as necessary to change installation settings, or **Cancel** to cancel the installation.

2. Before starting or canceling the installation, you can save an XML file with your installation settings. This XML can then be used for a scripted installation (see “Scripted Installation” on page 37).

   To save the XML file, click the file symbol in the Summary screen.

3. Select **Start** to begin installation.

4. The system performs an automated system check before it proceeds with the listed activities.

   If a **system check passed** message appears, installation continues.

   If a **system check failed** message appears, you can either:
   - Decline to view the system report, and continue installation.
   - Decline to view the system report and postpone installation.
   - View the system report, and decide to continue installation.
   - View the system report and postpone installation until the problem is fixed.

   **NOTE**
   To view the system report as PDF file, Adobe PDF Reader must be installed (see “Install Adobe PDF Reader” on page 29).

5. If an installation verification was completed as part of this installation, review the *Software Verification Report*. If the report indicates failure, verify the computer requirements and reinstall the data system. Do not use the system until the Software Verification Report gives a ‘pass’ result.

6. Click **Next** to proceed to the **Installed Features** screen.

7. Click **Finish** to close the installation wizard.
The basic installation of the data system software is complete.

There is a 60-day Startup License for this system, and the expiration period starts with the installation.

To request and download your final software license and add the license file to your system, see the Licensing chapter in this guide.

After you have acquired and installed your final software license, you will continue to prepare your data system for operation by end users by configuring projects, users, and instruments. This is accomplished through the OpenLAB CDS Control Panel, see the Configure OpenLAB CDS ChemStation Edition in the Control Panel chapter in this guide.
Scripted Installation

The OpenLAB CDS Master Installer supports a command line mode for installation, the *scripted installation*. This mode supports installation, upgrade, repair, and uninstallation. You can execute scripted installations either manually or as part of software management systems such as LANDesk or HP CM. With the corresponding parameter (-q), the scripted installation completes unattended.

About Scripted Installation

The OpenLAB CDS Master Installer supports a command line mode for installation, the *scripted installation*. This mode supports installation, upgrade, repair, and uninstallation. You can execute scripted installations either manually or as part of software management systems such as LANDesk or HP CM. With the corresponding parameter (-q), the scripted installation completes unattended.

Export as XML

The Master Installer supports a feature to export the installation parameters into an XML file which you can then use for the scripted installation.

This feature is also supported for upgrade and repair. However, for these cases the exported installation XML file is not appropriate. For scripted repair and upgrade, you must prepare specific XML files using the respective Master Installer wizards.

1. Launch the OpenLab CDS Installation Wizard.
2. Follow the installation instructions.
3. When you have reached the *Summary* screen, click the icon on the top right corner to export the installation parameters to XML. Save the file on a physical drive.

**NOTE**

Installation file and XML file must not be in the same file path.

You can now use the XML file for the scripted installation.
Parameters and Return Codes

Parameters

You can call Agilent.OpenLAB.CDSInstaller.exe in command line mode with the following parameters:

- `-i`
  Install or upgrade

- `-r`
  Repair

- `-u`
  Uninstallation

- `-q`
  Silent mode — no installation or uninstallation wizard will be shown.

- `-reboot`
  Reboot automatically after successful installation, repair, upgrade, or uninstallation. The system will reboot if the return code is either 0 or 17. A warning message will be shown in the command prompt 10 min before the system is rebooted. In addition, a Windows dialog opens 2 min before reboot.

- `KeepComponents`
  Optional parameter for the uninstallation process, which can contain one or more shared components that should stay on your system. Without this parameter, all OpenLAB CDS components will be removed from your system. To keep certain shared components, list the corresponding IDs from the table below in double quotes and separated by comma.

<table>
<thead>
<tr>
<th>Component Name</th>
<th>Id</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Verification Tool</td>
<td>IQT</td>
</tr>
<tr>
<td>Microsoft SQL Server</td>
<td>SQLServer</td>
</tr>
<tr>
<td>I0 Library</td>
<td>IOLibraries</td>
</tr>
</tbody>
</table>

- `ConfigurationXML="<ConfigurationXMLFilePath>"`
  The XML file contains all required inputs of the Master Installer to install, upgrade, or repair a certain topology (see “Export as XML” on page 37). Replace `<ConfigurationXMLFilePath>` with the correct file path and XML file name.
NOTE
Do not enter a blank before or after the equals (=) sign. The scripted installation and uninstallation mode will not work as expected.

Return Codes

After installation, uninstallation, upgrade, or repair in the command line mode, the system will return a number code which is explained below.

Table 2 Return codes

<table>
<thead>
<tr>
<th>Error/Return Code</th>
<th>Return value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unknown (default)</td>
<td>-1</td>
</tr>
<tr>
<td>Success</td>
<td>0</td>
</tr>
<tr>
<td>CoreComponentFailure</td>
<td>1</td>
</tr>
<tr>
<td>NonCoreComponentFailure</td>
<td>2</td>
</tr>
<tr>
<td>TestConnectivityFailure</td>
<td>3</td>
</tr>
<tr>
<td>ExpectedWindowsInstallerNotInstalled (WI 4.5 missing)</td>
<td>4</td>
</tr>
<tr>
<td>ParameterMismatchError</td>
<td>5</td>
</tr>
<tr>
<td>CannotProceedWithFreshInstallation</td>
<td>6</td>
</tr>
<tr>
<td>CannotProceedWithUpgrade</td>
<td>7</td>
</tr>
<tr>
<td>CannotProceedWithUninstallation</td>
<td>8</td>
</tr>
<tr>
<td>CannotProceedWithRepair</td>
<td>9</td>
</tr>
<tr>
<td>CannotProceedWithReRegistration</td>
<td>10</td>
</tr>
<tr>
<td>ReRegistrationNotSupported</td>
<td>11</td>
</tr>
<tr>
<td>IncompleteTopologyFound</td>
<td>12</td>
</tr>
<tr>
<td>InvalidUNCPath</td>
<td>13</td>
</tr>
<tr>
<td>MissingInstallable</td>
<td>14</td>
</tr>
<tr>
<td>NotAStrongPassword</td>
<td>15</td>
</tr>
<tr>
<td>DowngradeNotSupported</td>
<td>16</td>
</tr>
<tr>
<td>RestartRequired</td>
<td>17</td>
</tr>
</tbody>
</table>
# 2 Install the Software

## Scripted Installation

<table>
<thead>
<tr>
<th>Error/Return Code</th>
<th>Return value</th>
</tr>
</thead>
<tbody>
<tr>
<td>RegistryCleanupError</td>
<td>18</td>
</tr>
<tr>
<td>InvalidInputXML</td>
<td>19</td>
</tr>
<tr>
<td>InvalidMode</td>
<td>20</td>
</tr>
<tr>
<td>SitePrepFailure</td>
<td>21</td>
</tr>
<tr>
<td>DatabaseConnectionFailed</td>
<td>22</td>
</tr>
<tr>
<td>DotNetFramework4NotInstalled</td>
<td>23</td>
</tr>
<tr>
<td>OLSSConnectionFailed</td>
<td>24</td>
</tr>
<tr>
<td>PDFReaderNotInstalled</td>
<td>25</td>
</tr>
<tr>
<td>AllComponentsInstallationFailed</td>
<td>26</td>
</tr>
<tr>
<td>SomeComponentsInstallationFailed</td>
<td>27</td>
</tr>
<tr>
<td>Failed</td>
<td>28</td>
</tr>
<tr>
<td>AddOnListEmpty</td>
<td>29</td>
</tr>
<tr>
<td>EULANotAccepted</td>
<td>30</td>
</tr>
<tr>
<td>ScriptedNotSupported</td>
<td>31</td>
</tr>
</tbody>
</table>
Installation, Upgrade, or Repair

In installation mode, the OpenLAB CDS Master Installer checks if .Net Framework is present on your system. If not, it will automatically be installed. Select Accept to agree with the license agreement.

The Master Installer evaluates the products already installed on your system. Depending on the installed components, the Master Installer will offer one of the following options:

- Start a fresh installation
- Upgrade
- Repair

If a required installable is missing, the Master Installer will create an entry in a log file, and, depending on the component type, will continue or rollback the installation. A corresponding error code will be returned in such scenarios.

Preparations

You must have copied all installation files to a centralized folder (see “Step 3: Copy Installation files to a Centralized Folder for Installation (Optional)” on page 31). This step is mandatory for scripted installation.

1 Right-click the executable of the command prompt or Power shell prompt, and run it as administrator.
   
   You will get a return code for the scripted installation only if you start it as administrator.

2 Navigate to the location where you have saved the installation files.
   For example: C:\CDS

3 To start the installation, call Agilent.OpenLab.CDSInstaller.exe with the following syntax:
   
   \Agilent.OpenLab.CDSInstaller.exe -i ConfigurationXML="<path to xml file>" -q -reboot
   
   For example:
   
   Agilent.OpenLab.CDSInstaller.exe -i ConfigurationXML="c:\settings\ConfigurationXML.xml" -q -reboot
   
   With this command, you start the installation wizard without a user interface, and automatically reboot the system.
Uninstallation

1. Right-click the executable of the command prompt or PowerShell prompt, and run it as administrator.
   You will get a return code for the scripted uninstallation only if you start it as administrator.

2. Navigate to the location where you have saved the installation files.
   For example: C:\CDS

3. To start the uninstallation, call Agilent.OpenLab.CDSInstaller.exe with the following syntax:

   ```command
   Agilent.OpenLab.CDSInstaller.exe -u KeepComponents="<list of components>" -q -reboot
   ```

   For Example:
   ```command
   Agilent.OpenLab.CDSInstaller.exe -u KeepComponents="IQT,IOLibraries" -q -reboot
   ```

   With the KeepComponents parameter, you can specify a list of shared components that you want to keep on the system (see “Parameters” on page 38). With the command given in the example, the OpenLAB CDS components Software Verification Tool (IQT) and IO Library (IOLibraries) will be kept.

Logging and Tracing

All exceptions, errors and information messages are logged in the following locations:

- During installation, upgrade, or repair: under `<BaseInstallDirectory>\Logs`
- During uninstallation: under `<User’s Temp>\<Company Name>\Logs\<Log folder>\<Wizard Name>.txt`
3

Post Installation Tasks

Configure the Antivirus Program 44
Configure Default Printer 46
Add Shortcut to Public Folder 47

This chapter describes tasks that are relevant after finishing the installation.
Configure the Antivirus Program

Be sure to open the firewall ports listed in the Firewall Settings in the *OpenLAB CDS ChemStation Edition Requirements* guide.

**NOTE**
Running antivirus programs might influence the behavior and performance of your computer. Some virus scanners might cause issues when used with OpenLAB CDS ChemStation Edition. The application is tested with Symantec Endpoint Protection 12.x and with Microsoft Security Essentials.

In order for the OpenLAB software to function correctly, you should configure any antivirus real time protection software with the following folder exclusions. They should only be scanned while the instruments are idle and no data acquisition takes place. Refer to your specific antivirus software documentation on how to configure folder exclusions.

<table>
<thead>
<tr>
<th>Process</th>
<th>Directory</th>
<th>File name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data acquisition</td>
<td>%public%\Documents\ChemStation (or the corresponding folder for instrument data that you provided during installation)</td>
<td>Data, methods, sequences, reports etc.</td>
</tr>
<tr>
<td>ECM upload/download</td>
<td>%temp% for Windows users (=Users' temp directory)</td>
<td>*.ssizip</td>
</tr>
<tr>
<td>Standard reports</td>
<td>%temp% for Windows users (=Users' temp directory)</td>
<td>~p3d*.tmp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>~job*.tmp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Hpspl00.que</td>
</tr>
<tr>
<td>CDS intelligent reports</td>
<td>%LOCALAPPDATA%</td>
<td>Files on:</td>
</tr>
<tr>
<td></td>
<td>%APPDATA%</td>
<td>• Agilent</td>
</tr>
<tr>
<td></td>
<td>%PROGRAMDATA%</td>
<td>• Agilent Technologies</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Agilent_Technologies,_Inc</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• IsolatedStorage</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Temp</td>
</tr>
<tr>
<td></td>
<td></td>
<td>e.g.: C:\Users\xxxxx\</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AppData\Local\Agilent</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Technologies\Intelligent</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Reporting\RawDataFileCache</td>
</tr>
</tbody>
</table>
If your antivirus software includes program or executable deny execution settings, ensure that the following program files are not denied execution. You can use the windows search feature to find the specific folder each program file is located in.

- agilentolibrariesservice.exe
- chemmain.exe
- apg_top.exe
- iprocsvr.exe
- iproc8491.exe
- msinsctl.exe
- httpdmsd.exe
- epcsetup.exe

**NOTE** Depending on your specific configuration, some of the listed folders or files may not exist on your system.
Configure Default Printer

Every Windows user who runs ChemStation needs a default printer configured in the user profile. The printer driver must be for a physical printer, even if the printer is not connected. Configuring a to-file printer such as a PDF or XPS writer is not sufficient.
Add Shortcut to Public Folder

By default, user data such as master methods, sequence templates, report templates, raw data etc. is located in the public documents folder \Users\Public\Documents\ChemStation. You define this folder during the installation. The system creates a shortcut to the defined folder under Instrument Data in the Windows Start menu.

In Windows 7, a shortcut to public documents is automatically available in the Windows Explorer.

In Windows 10, the Windows Explorer is organized differently. To provide easy access to that folder, we recommend that you pin the Instrument Data folder to the Start menu.

1. Navigate to the Instrument Data shortcut in the Start menu.
2. Right-click the icon, then select Pin to Start.
3 Post Installation Tasks
Add Shortcut to Public Folder
4
Optional Procedures

Install Additional Software and Drivers  50
Run a Software Verification after Software Installation  51
Transform a Workstation to a Networked Workstation  52
Improve Performance on Offline Machines  54
Protect ChemStation Folders with Secure File I/O  55
Change the PC Name  56

This chapter contains information on the Additional Drivers and Software wizard, on the Software Verification Tool, and other helpful procedures.
Install Additional Software and Drivers

OpenLAB CDS ChemStation Edition offers a wizard to help you installing additional software, such as drivers for third-party instruments. To open the wizard, go to **Start > All programs > Agilent Technologies > OpenLAB > OpenLAB Additional Software and Drivers.** Follow the wizard to install the required software.

**Prepare Network Drives**

If the additional software is located on a network drive, you must prepare the network drive to make it accessible by the wizard. Without this preparation, Windows security prevents the wizard from accessing those drives.

1. Map the drive to a letter.
   - For example, map the drive as Z: using the shared path "\\<machine-name>\OpenLABCDS".
   - This maps the drive for the logged-in user.

2. Open the command prompt in elevated mode (run as administrator), and map the drive using the **net use** command.
   - For example, `net use Z: "\\<machine-name>\OpenLABCDS"`
   - This maps the drive for the local administrator account. The mapped drive is now visible to both logged-in user and administrator, and can be selected in the wizard.
Run a Software Verification after Software Installation

The Software Verification Tool (SVT) provides documentary evidence that your system has been built and installed correctly, and that all design specifications have been met.

1. Using your Windows operating system, go to Start > All Programs > Agilent Technologies > Software Verification Tool.

2. Select **Qualify**.
   The system will run the application and generate a Software Verification Report.

3. If the report indicates failure, verify the computer requirements and reinstall the data system.
   Do not use the system until the Software Verification Report gives a ‘pass’ result.
Transform a Workstation to a Networked Workstation

With Networked Workstations, you use a separate server to control the system. You can access all information provided by the Shared Services component from any Networked Workstation. For example, you can see on each workstation which instruments are available and which status (Online, Offline, Error, In Run, Not Ready, etc.) the instruments currently have. Also licenses and user accounts are managed centrally on the Shared Services server.

- You must already have installed an OpenLAB CDS Shared Services Server, (see OpenLAB CDS ChemStation Edition Networked and Distributed System Installation and Configuration, CDS_NWSDS-Installation.pdf on disk 1), or an OpenLAB Server (see OpenLAB Server Installation, OpenLABServerInstallationGuide.pdf on disc ol-ds).

- Make sure that the Shared Services versions on the workstation and the server are identical. If not, upgrade your system before doing the transformation. See “Upgrade ChemStation Edition to Latest Version” on page 79.

For more information on temporary support of mixed version systems during an upgrade phase, refer to the OpenLAB CDS ChemStation Edition Guide for Administrators (CDS_Admin.pdf).

Conflict of multiple instruments having the same name

Check if the instruments used on the Workstation have a name that already exists in the network. If this is the case, or if you are not sure:

➔ Before starting the transformation: Copy the data, methods, and sequences from the relevant instrument to a local backup folder. Then delete the instrument on the Workstation.

➔ After the transformation, configure a new instrument, and copy back the data from the local folder.

1. From the OpenLAB CDS ChemStation Master Installer, select Maintenance.
2. Select Transformation of an OpenLAB Standalone Workstation into a Networked Workstation.
3  Enter the server name and the authentication service used by the server. If the server requires authentication, you will be asked for the credentials of an OpenLAB Shared Services administrator.

4  Start the transformation. All instruments will be registered on the server.
Improve Performance on Offline Machines

Computers running OpenLAB CDS ChemStation Edition may exhibit slow performance when they are not connected to the Internet.

The windows operating system has routines built into its operation that causes it to continuously search for an online connection in order to update to all the latest Windows security certificates when using secure software.

Use the following system settings on all workstations, clients, AICs, and servers to remedy this problem.

1. Open Internet Explorer and select **Tools > Internet Options**. In the **Advanced** tab, clear the following check boxes:
   - **Security > Check for publisher’s certificate revocation**
   - **Security > Check for server certificate revocation**

2. Windows 7: Change the following registry keys:
   - `[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\SystemCertificates\AuthRoot]`
     "DisableRootAutoUpdate"=dword:00000001
   - `[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Policies\Microsoft\SystemCertificates\AuthRoot]`
     "DisableRootAutoUpdate"=dword:00000001

3. Document that you turned off the Root Certificates, as this can prevent users from installing other applications.
Protect ChemStation Folders with Secure File I/O

ChemStation files such as data, methods, or sequences are stored in various local folders. To ensure data integrity, ChemStation offers the Secure File I/O function. If you enable this function, all folders will be protected against modifications from outside ChemStation or in Open or Save As dialogs.

For more information, refer to the Folder Protection with Secure File I/O chapter in the OpenLAB CDS ChemStation Edition Guide for Administrators.
Change the PC Name

Considerations

A change of the PC name may be scheduled to avoid duplicate names in a network or can be due to a policy change. If you need to change a PC name after installation, consider the following:

- The license file for the PC is no longer valid
  Instruments are licensed by installing files that are specifically created for a given configuration. The text of the license files contains references to the computer name and the hardware address of the network card. If one of the parameters is changed, the license no longer applies.

- The instrument controller will no longer be resolved
  An instrument controller is a workstation or AIC that is used to control an instrument. This can be either a physical instrument for acquisition or for Data Analysis only.
  During installation of a standalone workstation the PC name of this workstation is registered as the Instrument Controller. If the name is changed after installation, the registered name is not updated automatically. Instead the old name remains as an unresolved orphan and instruments that are configured with this name will no longer start.
• Instruments connected to an unresolved instrument controller cannot be started and cannot be deleted

**NOTE**
All instruments that are connected to the relevant instrument controller must be deleted *before* changing the PC name.

**NOTE**
To make sure that a DNS server can resolve the computer name, follow the internet standard for protocols (*RFC952*) and use only the following characters:

- Letters (a-z, A-Z)
- Digits (0-9)
- Hyphen (-)

Do not use an underscore.
Procedure to Change the PC Name

**Figure 3**  PC name change - flow chart

1. In the **Instruments** section in the OpenLAB CDS Control Panel, delete any instruments that are still assigned to the unresolved instrument controller.

2. In the **Administration > Instrument Controllers** section in the OpenLAB Control Panel, click **Delete Instrument Controller** in the ribbon to remove the old name from the list of instrument controllers.

3. Rename the computer.
After the change to the new name, register this new PC name with Shared Services. This is done by executing the file `RegisterCS.bat` in the ChemStation Core folder:

5. Generate and install a license file with the new PC name (host name).

6. Navigate to `<Agilent Home> > OpenLAB Data Store > Configuration`, and run `DataStoreConfigurationFinalizer`.
   - This reapplies all security settings and restarts the system.

7. Create new instruments.
4 Optional Procedures

Change the PC Name
This chapter contains information on how to obtain and install a license.
About OpenLAB Licensing

License Types

The license file is a collection of Product, Instruments and Add-on licenses (or activation keys), and is installed to your OpenLAB CDS System.

The licenses or activation keys in the license file can either be Shared or Counted:

- Shared licenses — system computers and other components can have shared, or add-on, licenses — because they share a core license.
- Counted licenses — these licenses are part of the OpenLAB CDS ChemStation Edition floating licensing strategy. They are not permanently assigned to any one component. Instead they are automatically assigned to components, such as AICs and instruments, while the components are starting up. The licenses are automatically returned when the component is closed. The license management program controls license issuance and retrieval.

In this case, the only requirement is that a component is licensed while running. You only need enough licenses for all components running concurrently, rather than for each installed component.

A startup license for the system allows you to run OpenLAB CDS for 60 days after the installation. In order to run the data system software after the 60-day period, you must install your license file.

License File

A license file will contain your software license. This file is installed on the workstation. The license file is bound to this computer, and cannot be moved to another workstation without regenerating the license in SubscribeNet.

Information in the license file defines the number of instruments and other options that may be used concurrently with your system.

The most efficient way to manage and maintain your licensing is through the Internet.
Get a License

Obtain a License with SubscribeNet

Use the following procedure to generate and download your license. In case you do not have internet access, skip to the section “Other Ways to Obtain a License” on page 66.

If you are a new user who has not registered with SubscribeNet, continue with the section New Users.

If you have registered with SubscribeNet, skip to the section Users registered with SubscribeNet.

Prerequisites

To generate, download, and install a final license for your product, you will need:

- The authorization code label provided in the lavender envelope containing your Software Entitlement Certificate.
  
  If you have not received a lavender envelope for your product, contact your vendor or internal support.

- The URL for SubscribeNet from the Software Entitlement Certificate.

- The host name of the computer where the Control Panel is running.

- The MAC address.
  
  To retrieve your MAC address from a computer where OpenLAB CDS ChemStation Edition is already installed, open the Control Panel and browse to the Administration > Licenses section. Use the Copy MAC Address or Save MAC Address function to obtain the MAC address for license generation.
  
  During this process you will have to enter the MAC address of your license server. For workstations, this is the local computer. For client/server systems, this is the server.

NOTE

If any changes are made to the computer name or domain reference after the license is installed, remove the license. A new license will need to be created in SubscribeNet, downloaded, and installed.

NOTE

If the network adapter that provides the MAC address used during license creation is removed from the machine, your license will no longer be valid. A new license will need to be generated with a currently available MAC on the license server.
New Users

1. Go to https://agilent.subscribenet.com/control/agil/AgilRegisterToAccount to register the product with SubscribeNet.

2. On the registration page, enter the authorization code from the label and complete the profile information (required fields are marked with an asterisk *).
   The email address you enter will become your login ID.

3. Click Submit. The system will generate and display an account name for you. SubscribeNet will send a welcome email with your login ID and password.

4. Log in to SubscribeNet using your login ID and password.
   Once you log in, you can use the online user manual link for help with any questions you have.

5. Select Generate or View licenses from the left navigation bar.

6. Follow the prompts to generate your new license.
   You will be prompted for the HOST NAME of the computer. The host name you enter must match with the network name of the computer where the Control Panel is running. Do not include any DNS suffix (domain.com) references in the entered machine name.

7. When the system generated the license, view its details, then click Download License File. Save the license file to your computer and to a backup location (such as a portable storage device).
   Use your login ID and password when you revisit the Agilent SubscribeNet site to regenerate a license file, add new authorization codes, or further configure the license for your system.
Users registered with SubscribeNet

1 If you already have a SubscribeNet account, use https://agilent.subscribenet.com/.
   Lost your SubscribeNet password? Use https://agilent.subscribenet.com/control/agil/password to have it emailed to you.

2 Select the SubscribeNet account associated with this authorization code, if you have more than one account.

3 From the SubscribeNet navigation pane, select Register Authorization Code. This will allow you to enter your new authorization code and make available the new license entitlements.

4 Follow steps 5 through 7 in the previous procedure, New Users, to generate or view your new licenses.
Other Ways to Obtain a License

If you are unable to generate a license, contact your nearest Agilent technical support office. A representative will tell you how to submit an OpenLAB CDS License Generation Form in your location.

Offline Licensing

If an internet connection is not available in your laboratory:

You or your local on-site service engineer will collect the necessary information from you to allow Agilent to create a license account on your behalf. For phone support in your region, call the sales and service number for your region. See the Appendix for a list of numbers for various countries.

*Required Customer Information for Agilent License Support:*

The following information must be provided to Agilent in order to enable us to create a licensing account on your behalf.

1. Collect Account Information:

   Your account name will be your company name and Lab name separated by a comma. Employee information provided here will be used to define the first administrator of your account for future access to the system as required. Please prepare the following pieces of information prior to contacting your local Agilent sales and service center in order to expedite service:
   - Company Name
   - Lab/Department Name
   - First Name
   - Last Name
   - E-mail address
   - Job Title
   - Phone #
   - Address, City, State/Province, Postal Code, Country
2  Collect Authorization Code(s):
   The authorization code is an alpha-numeric code provided on a label which is enclosed in a lavender envelope. If you have received more than one code you must provide all codes to ensure that all ordered licenses are granted to your account.

3  Receiving your license:
   Once the above information is provided Agilent will then work on your behalf to generate a license file through SubscribeNet. The license file will either be sent to your shipping address (on a CD), or your local FSE will deliver it in person (usually on USB media). Once your license is received follow the below section on “Install your License” to finish installing your license on your CDS system(s).
Install Your License

The license must be added to your system using the Control Panel.

1. Start the Control Panel shortcut on the desktop or go to Start > All Programs > Agilent Technologies > OpenLAB Shared Services > Control Panel.

2. Navigate to Administration > Licenses.

3. In the ribbon, click Add License.

4. Choose to install the license by:
   - Using the license file option to browse to and open the license file (.lic) saved from the license generation process in SubscribeNet.
   - Selecting the License Text option and copying the license text from a text file received into the provided field.

5. Click OK.

The Administration interface in the Control Panel will now display the status of installed licenses.
Configure OpenLAB CDS ChemStation Edition in the Control Panel

Configure Authentication 70
  Select an Authentication Provider 71
Configure Security Policy 72
Configure Users/Groups/Roles 72
  Create or import users 73
  Groups 73
  Roles and Privileges 74
  Specific Roles for Individual Instruments 75
Install your License 76
Configure Instruments 77

This chapter describes the initial configuration steps after installing the software. Refer to the online help for more information.
Configure Authentication

Authentication providers are used to prove the identity of users that log in to the system. OpenLAB CDS Shared Services support the following Authentication providers:

- **None**
  
  In this mode, no login screen is shown when you access the OpenLAB Control Panel. The user is automatically logged in to the application with security disabled. All log entries record the user as "Anonymous". With the authentication provider **None**, the Security Policy and User Management nodes are unavailable in OpenLAB Control Panel.

  **NOTE**
  
  With the authentication provider **None**, any activity logs will display a generic **System** operator with no additional identification. This is not recommended for regulated environments.

- **Internal**
  
  In this mode, the user's credentials are created and stored in the OpenLAB CDS Shared Services database. You are asked to create an administrator account for OpenLAB CDS Shared Services before setting up other users. This is the only mode in which you can create new users within the system.

- **Windows Domain**
  
  You import existing Windows users into OpenLAB CDS Shared Services. The authentication is done either by a Windows Active Directory domain or NT 4.0 Domain within the Enterprise. Shared Services only use the identity and password of the mapped users; roles and privileges for OpenLAB CDS are still configured with the Shared Services.

- **ECM**
  
  In this mode, an OpenLAB ECM system is responsible for authentication. When you start the OpenLAB Control Panel, the application will prompt for ECM credentials to validate a user. You must choose an existing ECM user as an administrator for the Shared Services. The Search function helps you to find specific ECM users. The Shared Services only use the identity and password of the mapped users; roles and privileges for OpenLAB CDS ChemStation Edition are still configured with the Shared Services.
Select an Authentication Provider

1. Launch the Control Panel.
2. Navigate to Administration.
3. In the navigation pane, select System Configuration.
4. In the ribbon, click Edit System Settings.
5. Select the required authentication provider from the drop-down list, then click Next.
6. Provide user credentials:
   a. For Windows Domain: Select the check box to use a domain user, and provide user credentials with the rights to obtain user and group information. Then click Select Account to open the Search Users dialog and select an administrator account.
   b. For Internal: Click Create Account to create a new administrator account for OpenLAB CDS ChemStation Edition.
7. Confirm your settings. When complete, the Control Panel will restart.
Configure Security Policy

If you need to comply with specific standards, adjust the security policy as required.

With the authentication provider **Internal**, you can set all parameters in the Control Panel. With an external authentication provider, you can only set the inactivity time in the Control Panel; all other parameters are defined by the external system.

1. Launch the Control Panel and navigate to **Administration**.
2. In the navigation pane, select **Security Policy**.
3. In the ribbon, click **Edit Security Policy**.

Configure Users/Groups/Roles

With internal authentication, you create the required users in the OpenLAB Control Panel. With external authentication system such as Windows domain, you import the users.

To define what users are allowed to view or do, OpenLAB CDS ChemStation Edition offers predefined roles and allows you to define your own specific roles. Roles are equipped with numerous specific privileges.

Each user can be member of multiple groups. You must assign one or more specific roles to each group. You can also assign roles to single users; however, for the sake of clarity, it is strongly recommended to assign roles only on the group level. Every member of a group automatically has all roles of this group.

1. Launch the Control Panel and navigate to **Administration**.
2. In the navigation pane, select **Users**, **Groups**, or **Roles**.
3. Create new items, or edit the existing ones.
Configure OpenLAB CDS ChemStation Edition in the Control Panel
Configure Users/Groups/Roles

Create or import users

Use the OpenLAB Control Panel to manage the roles and privileges. You can create custom roles, or assign one or more of the predefined roles to give users varying degrees access.

Add users (Internal Authentication only)

1. From the navigation pane, click Administration > Users.
2. In the Create User dialog, provide the relevant parameters:
   - Enter the name and password for the new user.
   - By default, the new user will need to change the password at next logon. If this is not required, clear the User must change password at next logon check box.
   - In the Role Membership tab, assign the user to an appropriate role. You can use the default roles, or prepare your own roles in the Control Panel under Administration > Roles.
3. Click OK.

Import users

To add Windows domain users to your system, you must have privileges to obtain user and group information from the domain.

1. From the navigation pane, click Administration > Users.
2. In the ribbon, click Import.
3. In the Search Users dialog box, enter search string for the username.
4. From the Search Results list, select the user you want to import, and click Add. The user is added to the Selected Users list.
5. Repeat steps 2 through 4 until you have added all the user names that you want to import to the Selected Users list, then click OK.

Groups

If you use an external authentication provider, you can either import the names of groups that exist in the external system, or create new internal groups. There is no limit on the number of groups that can be mapped or created.
Configure OpenLAB CDS ChemStation Edition in the Control Panel

Configure Users/Groups/Roles

Assign users to groups either in the external system or in the Control Panel. If you need additional user assignments that are relevant only for OpenLAB CDS ChemStation Edition, create them in the Control Panel. Otherwise it is sufficient to only import the groups and assign the required roles to the groups.

If you delete or unmap a group, the users who were members in this group remain unchanged.

Roles and Privileges

Roles are used to assign privileges to a user or a user group globally or for a specific instrument or location. The system contains a list of predefined roles which are installed as part of the system installation (for example, Instrument Administrator, Instrument User, or Everything). Each role has certain privileges assigned.

Privileges are grouped according to the three main role types (Project role, Instrument role, and Administrative role). When you assign privileges to a role, you first select the required role type and then select the privileges related to this role type. Each role can only have privileges of one specific role type; the only exception is the predefined role Everything, which has all privileges of all role types. Users or groups may require multiple roles to perform system functions. For example, a user with the role Chemist may need another role such as Instrument User with the privilege to run an instrument.

You can create a tree of different locations in the Control Panel, and add instruments to the relevant locations. For each instrument or instrument group, you can assign different Instrument roles (see also “Specific Roles for Individual Instruments” on page 75). For example, a user can have the role Instrument Administrator for one instrument, and Instrument User for another instrument.

You can also create a tree of different projects or project groups in the Control Panel, and assign different Project roles for different projects (see also “Specific Roles for Individual Instruments” on page 75). For example, a user can have the role Project Administrator in one project, so that he can manage the settings in the Control Panel. In a second project, he may have a role that allows him to edit the content of a project, but not to change the project settings.
Configure Users/Groups/Roles

Specific Roles for Individual Instruments

By default, the roles of users or groups are globally set for all locations or instruments. The role settings are inherited from the root node **Instruments**. In order to assign a different role to a user or group for one specific node, you can deselect the **Inherit privileges from parent** check box in the **Edit Privileges** dialog for the required node. Afterwards, you can assign a different role that will be valid only for the specific node.

You can assign **Instrument** roles to individual locations or instruments.

**Administrative** roles are always set globally.

---

<table>
<thead>
<tr>
<th>Role Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrative privileges</td>
<td>These privileges are globally assigned to a user or group and cannot be changed on the instrument/location level. They are the typical administration privileges such as <strong>Backup and restore</strong>, <strong>Manage security</strong>, <strong>Manage printers</strong> etc.</td>
</tr>
<tr>
<td>Instrument privileges</td>
<td>These privileges can be assigned globally or on the instrument/location level. Privileges for instruments are, for example, <strong>View instrument or location</strong> and <strong>Run instrument</strong>. Users need the <strong>View instrument or location</strong> privilege on the global level to see the locations and instruments tree in the Control Panel.</td>
</tr>
<tr>
<td>Project privileges</td>
<td>Privileges to control the available options inside the ChemStation application.</td>
</tr>
</tbody>
</table>
Install your License

The license must be added to your system using the Control Panel.

1. Start the Control Panel shortcut on the desktop or go to Start > All Programs > Agilent Technologies > OpenLAB Shared Services > Control Panel.

2. Navigate to Administration > Licenses.

3. In the ribbon, click Add License +.

4. Choose to install the license by:
   - Using the license file option to browse to and open the license file (.lic) saved from the license generation process in SubscribeNet.
   - Selecting the License Text option and copying the license text from a text file received into the provided field.

5. Click OK.

The Administration interface in the Control Panel will now display the status of installed licenses.
Configure Instruments

1. Launch the OpenLAB Control Panel and navigate to Instruments.
2. Click Create in the ribbon to create a new instrument.
3. Select the new instrument, and click Configure Instrument in the ribbon.
4. It is recommended that you use Auto Configuration to configure your instruments: Select a module, click Auto Configuration, and provide the instrument's IP address or hostname.
5. Confirm your settings

Configure OpenLAB CDS ChemStation Edition in the Control Panel
Configure Instruments
Upgrade ChemStation Edition to Latest Version

Planning the Upgrade  80
Convert Classic Instrument Drivers to RC.NET  82
License Upgrade  85
  Get Upgraded License File  85
  Add Upgraded License File to the System  87
Run the C.01.08 Upgrade Wizard  88

This chapter describes the upgrade from ChemStation C.01.07. If you upgrade from an older ChemStation revision, upgrade to C.01.07 first. For information on upgrading from ChemStation A.0x or B.0x, please refer to the migration guide (CDS_CS-data-Migration.pdf).
Planning the Upgrade

A direct upgrade, using the Upgrade Wizard, is supported from ChemStation C.01.07 or higher. Older ChemStation revisions must be upgraded to C.01.07 in a first step. The upgrade procedure depends on the revision of your currently installed ChemStation Edition:

- **C.01.06, C.01.05**
  - Run the C.01.07 SR3 upgrade wizard. For details, please refer to the C.01.07 SR3 installation guide.

- **C.01.04–C.01.01**
  1. a Uninstall the old ChemStation.
  2. b Uninstall specific drivers or Add-On.
     - If your system is configured to use one of the following drivers or Add-Ons, uninstall them using the Microsoft Control Panel:
       - ELSD (G7102A, G4261A/B or G4260A/B).
         - ELSD drivers will be supplied with a separate installer.
       - Agilent Cirrus GPC software for ChemStation (G7818A), versions earlier than 3.4.2; uninstall Cirrus Operational Qualification first, then uninstall Cirrus.
         - Version 3.4.2 of the Cirrus Add-On is required for ChemStation C.01.08.
       - M8370AA OpenLAB CDS Data Analysis Add-On.
         - The Data Analysis Add-On is not supported with ChemStation C.01.08.
  3. c Install C.01.08.

- **A.0x or B.0x**
  - For information on upgrading ChemStation A.0x or B.0x, please refer to the migration guide (CDS_CS-data-Migration.pdf).

Note that C.01.08 is supported on Windows 7 SP1 64 bit or Windows 10 only. An in-place upgrade from Windows 7 or 8.1 to Windows 10 on an existing ChemStation Workstation is not supported.
Classic instrument drivers, with exception of LC/MS instrument drivers, are no longer supported. It is recommended that you convert the corresponding instruments and methods to RC.NET driver prior to the upgrade (see “Convert Classic Instrument Drivers to RC.NET” on page 82).

Before upgrading a system, make sure that the Windows configuration meets all requirements. See “Configure your Workstation PC” on page 7.

**NOTE**

OpenLAB CDS ChemStation Edition C.01.08 no longer controls the Agilent 5890 GC instrument. Do not upgrade to rev. C.01.08 if using the 5890 GC.
Convert Classic Instrument Drivers to RC.NET

With C.01.08, only RC.NET drivers are available (with exception of MSD instrument drivers). Instruments using the classic driver must be reconfigured to use the RC.net driver. Agilent recommends to do this before upgrading to C.01.08.

To determine which instruments are using the classic driver, go to the OpenLAB Control Panel and select the instrument. Select Configure Instrument in the ribbon. The instrument is using the classic driver if the Use classic drivers checkbox is selected. Perform the following steps to reconfigure the instrument to use RC.NET.

1. Record the IP address for each Classic driver instrument.
2. Verify there is a backup of the methods and data to another location.
3. For your reference: Print the classic driver method settings or save the method listing to disk.
4. To reconfigure the instrument, select the instrument in the Agilent OpenLAB Control Panel.
5. In the ribbon, click Configure Instrument.
6. In the configuration dialog, clear the Use classic drivers check box.

The instrument is moved from the Selected Modules panel to the Configurable Modules panel.

7. Select the instrument in the Configurable Modules panel, then click the arrow to add the instrument to the Selected Modules panel again.
7 Upgrade ChemStation Edition to Latest Version
Convert Classic Instrument Drivers to RC.NET

**NOTE**

- If a current RC.NET driver is not yet available, you must install it manually before upgrading OpenLAB CDS ChemStation.

- For example, follow these steps to install the 35900E ADC RC.NET driver:
  
  a. Run the master installer.
  
  b. Go to Installation and open OpenLAB Additional Software and Drivers.
  
  c. When asked for the Add-on software, browse to Disk3 of the installation media, and to the Agilent 35900E RCNet folder to find the Agilent OpenLAB CDS ChemStation 35900 AtoD Drivers.msi file. The corresponding software will then be listed in the installer.

  d. Select the software in the list, and continue to install. The installation verification will automatically follow and should complete without errors.

8 Double-click the instrument under **Selected Modules**, and configure the previously recorded IP address. Click **Get Serial Number and Firmware** to get the corresponding entries.

![Figure 4](image)

**Figure 4** Example for 35900 configuration

9 Launch the newly configured instrument.
To convert a method to RC.NET driver, load the method. If a dialog like the following opens, click **OK**.

Review the method, and if no updates are needed, add a comment such as "Updated to RC.NET" to the method when saving it.

Methods are converted to RC.NET when loaded. After saving to disk, converted methods have an additional Agilent folder and RapidControl.InstrumentConfig file.
License Upgrade

Get Upgraded License File

You will need to upgrade your licenses in SubscribeNet prior to upgrading to the next version of OpenLAB CDS ChemStation Edition. We strongly recommend upgrading your workstation licenses before upgrading the core software. Standalone workstations which are upgraded to the new core software version, without a new workstation license, will not work until the new workstation licenses are added to the OpenLAB Control Panel.

If you are under SMA subscription, proceed as follows to upgrade your licenses:

1. During the following process, you will be prompted in SubscribeNet for the host name or MAC address of the workstation where OpenLAB CDS ChemStation Edition is already installed.

   To retrieve this hostname and MAC address, open the Control Panel and browse to the Administration > Licenses section. Note down the host name and use the Copy MAC Address or Save MAC Address function to obtain the MAC address.

2. Log into the Agilent Electronic Software and License Delivery (https://agilent.subscribenet.com/).

3. Navigate to Manage Licenses by Host. In the Host ID field, enter the previously noted MAC address, and click Search.
If the relevant host name does not appear, you may be managing your licenses in multiple SubscribeNet accounts. You will need to log into those accounts to upgrade those workstation licenses.

4 If your license(s) are eligible for an upgrade, you will see the **Upgrade All** button. Otherwise you will need to contact your Agilent Sales Representative to renew your Software Maintenance Agreement (see “Sales and Support Assistance” on page 97). To proceed with generating your upgrade license, click the button.

5 On the **Upgrade All Licenses for License Host** page, review the data, and confirm by clicking **Upgrade All**.

This upgrades the license file to the most current version. SubscribeNet will send you an email with a new license file.

6 Put the new license file on your system (see “Add Upgraded License File to the System” on page 87.

If you have multiple standalone Workstations, repeat this step for each individual workstation.

Note that each workstation's MAC address is the file name. This helps identify the correct license file to import into the workstation's Control Panel.
Add Upgraded License File to the System

If you have purchased new options, such as additional instrument controls or client license and regenerated your license in SubscribeNet, the upgraded license file must be re-applied to the system.

1 Start the Control Panel from any machine connected to the system you want to install the license for.

2 Navigate to Administration > Licenses.

3 In the ribbon, click Remove License \( \times \).

4 In the ribbon, click Add License \( + \).

5 Browse to and open the license file saved from the license generation process in SubscribeNet.

6 Restart the following Windows services:
   - Agilent OpenLAB License Server
   - Agilent OpenLAB Licensing Support
Upgraded ChemStation Edition to Latest Version
Run the C.01.08 Upgrade Wizard

Prerequisites
You are using OpenLAB CDS ChemStation Edition rev. C.01.07 or higher. Older revisions must first be upgraded to C.01.07 in a separate step.

For AICs and Networked Workstations: To preserve the instrument’s column table during the upgrade, go into each of the existing instrument folders (\ProgramData\Agilent Technologies\ChemStation\1, \ProgramData\Agilent Technologies\ChemStation\2, ...) and rename the file Config.reg into Config.bak. This step is not required if you use LC column tags to store the LC column information, or if GC column injection counts are irrelevant.

1. From the Master Installer Planning screen, switch to the Installation screen.
2. Select OpenLAB CDS ChemStation.
   If OpenLAB CDS ChemStation Edition is already installed, this automatically opens the upgrade wizard.
3. The workstation license must be upgraded, see “Get Upgraded License File” on page 85.
   Acknowledge that the license has been upgraded and click Next to continue.
4. Select I agree with the terms and conditions. You cannot proceed with the upgrade unless you agree to these terms. Click Next.
5. If an Authentication Provider has been configured: Enter the username and password of a user with system administration privileges in the OpenLAB Shared Services Settings for Registration screen. Click Next.
6. In the Summary screen of the Upgrade Wizard, the components for the upgrade are listed. Click Start to proceed with the upgrade.
   If an error occurs during the upgrade, an error message appears.
7. Select Finish to close the upgrade wizard.
8. After the upgrade, check if the settings in the ChemStation Administration Tool still match your original system settings before the upgrade.

As of rev. C.01.08, the Control Panel layout is upgraded for all installations. The new user interface is shown in the following figure:
Upgrade ChemStation Edition to Latest Version
Run the C.01.08 Upgrade Wizard

Figure 5  Control Panel user interface

Existing instrument configuration can remain unchanged after the upgrade.

**NOTE**
The Classic drivers are not supported with ChemStation C.01.08 and later. Please check section “Convert Classic Instrument Drivers to RC.NET” on page 82 for details.
Upgrade ChemStation Edition to Latest Version
Run the C.01.08 Upgrade Wizard
8
Uninstall the Software

About Uninstallation 91
Run the OpenLAB CDS Uninstallation Wizard 92

This chapter contains information on the uninstallation by using the OpenLAB Uninstallation Wizard. It also describes post uninstallation tasks that are essential if you plan to reinstall ChemStation on the same computer.

About Uninstallation

If the Master Installer was not used for installation, any manually installed additional software such as Headspace, PAL, or third party drivers must be uninstalled using the Windows Control Panel before OpenLAB CDS ChemStation Edition can be uninstalled.

Like the installation, the uninstallation of OpenLAB CDS ChemStation Edition is automated by the OpenLAB CDS ChemStation Master Installer.

For your convenience, the Master Installer uses the same user interfaces for the software uninstallation of all ChemStation configurations (standalone or networked workstation). The OpenLAB CDS Uninstallation Wizard is found under the Maintenance section of the Master Installer. It guides you through the uninstallation steps.

Do not use the Windows uninstallation tool for uninstalling OpenLAB CDS ChemStation Edition.
Run the OpenLAB CDS Uninstallation Wizard

1. Select **Start > Agilent Technologies > OpenLAB > Uninstall OpenLAB CDS**. The **OpenLAB CDS Uninstallation Wizard** opens.

2. In the **Shared Components** screen, select the **Uninstall Software Verification** and **Uninstall PostgreSQL** check box.  
   *Note:* Software Verification Tool needs to be uninstalled if you wish to re-install OpenLAB CDS at a later time

3. In the **Summary** screen under **Uninstallation of OpenLAB CDS Components**, there is a list of the components you want to uninstall.

4. Select **Start** to start the uninstallation.  
   If you want to abort the uninstallation, select **Cancel**. If you want to change any settings, select **Back**.  
   All listed components are automatically uninstalled, one after another.

5. When the uninstallation has finished, click **Finish** to close the uninstallation wizard.
9 Troubleshooting

Reconfigure Instruments Using Classic Drivers After Upgrade to ChemStation C.01.08

The chapter gives some troubleshooting hints.
Reconfigure Instruments Using Classic Drivers After Upgrade to ChemStation C.01.08

If you missed the recommendations from the driver preparation (see “Convert Classic Instrument Drivers to RC.NET” on page 82), ChemStation will start up, but instruments with the Classic driver will no longer be available. You will receive a notice that you need to reconfigure your instrument.

The classic driver instruments and methods are not updated to RC.NET automatically. To adjust them, perform the following steps.

To check if a classic method is used, go to Windows Explorer and view the contents of the corresponding method folder. The classic method will not have the Agilent folder listed.

1. Record the IP address for each Classic driver instrument.
2. Verify there is a backup of the methods and data to another location.
3. To reconfigure the instrument, select the instrument in the Agilent OpenLAB Control Panel.
4. In the ribbon, click Configure Instrument.
   A message is displayed, requesting you to reconfigure your instrument.
5. Click OK.
   The Configure Instrument panel opens. The Use classic drivers check box is no longer shown.
To update the instrument to use the RC.net driver, select the instrument in the **Configurable Modules** panel, then click the arrow to add it to the **Selected Modules** panel.

Enter the IP Address. **Only for 35900E A/D instrument:** Click **Get Serial Number and Firmware** to get the corresponding entries. For the example below the serial number and firmware version are updated upon successful connection to the 35900E A/D instrument.

This completes the setup of the instrument.

Click **OK** to load the instrument configuration.

Specify the **Method Load on Startup** option and select one of the following options:

- **Always ask the user to choose an option**
- **Download method to instrument on start up** (select this option to match the behavior of the classic driver)
- **Upload method from instrument**
- **New method from instrument**

Click **OK** to complete.

Launch the newly configured instrument.
To convert a method to RC.NET driver, load the method. If a dialog like the following opens, click OK.

Review the method, and if no updates are needed, add a comment such as "Updated to RC.NET" to the method when saving it.

Methods are converted to RC.NET when loaded. After saving to disk, converted methods have an additional Agilent folder and RapidControl.InstrumentConfig file.
Sales and Support Assistance

Please check the following web site for your local sales and support contact:

In This Book

This installation guide provides instructions to install and configure the Agilent OpenLAB CDS ChemStation Edition workstations.